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Undocumented Autodesk® Architectural Desktop Tips and Trick

Create Door/Window Assemblies from Linework

Door/Window Assemblies (and Curtain Walls) can be very powerful and flexible objects in ADT, but they
can be difficult to setup as a style. An easier method is to convert a sketch you create with lines and arcs:

1. Elevation Sketch
Draw a sketch of Assembly you want using lines and arcs —

use only single lines (don’t draw the widths of the frames \\\

and mullions). Be sure to make your sketch dimensionally == \\

accurate using your linework to represent the outside edge N

of frames and the center of mullions. \ N q

2. Contert to Door/Window Assembly R j

Right-click on the Door/Window Assembly tool on the Tool Door :

Palettes, chose “Apply Tool Properties to >", then “Elevation .= § wnw j

Sketch”. Follow the command prompts to select your : - T

linework and the baseline (which will become the sill). E o SRR Do e e
g W cutanwal Ez;y

| structursl colur  Delete Tool
Rename

Bl T

- Struckural Bear
5 Properties. .

Set Image from Selection. ..
Help

3. Save to Style ]

To Finish the process, highlight the newly created e e )
Door/Window Assembly, right-click and choose “Design e . &

Rules > Save to Style...”. Then, click the “New...” button — e
and give it a name. Frame | Hlien r

Division

You are now ready to insert your new Door/Window Assembly Style
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Undocumented Autodesk® Architectural Desktop Tips and Tricks

Add Elements to the Standard Style

When creating Door/Window Assembly Styles from linework, ADT will copy the “Standard” style, including
all its element definitions, to use as a template for the new style. So, if you set the default elements in the
“Standard” style to more usable sizes and you assign materials to those elements, you will have less work
to do after. Some examples:

F rames an d M u | | | ons [ Door /window Assembly Style Properties - Standard
Change the Default to be the size you typically use Goneral] Shape Desin s | 0verids| e | Clss

(i.e. 1 1/2"x4") and add other sizes for overrides [Es primary Grid ] 1542 Fome

-] Element Definitions | [ 13246 Frame
[ Divisions [0 15248 Frame,
o @ Toiils ] Dt Frame:

O

- {ii] Mulions

I n fl I I S Dour,-"window Assembly Style Properties - Standard

Change the Default to be the thickness of glazing you Genera] Shope Destn s | Dverides| Mot | Clss
typically use (i.e. 3/4") and add other object styles for LD e S e Boawint
overrides (i.e. single doors, double doors, and solid panels)

[0 piisiens [ W Door - Single Hinged

| [ Frosted Glass

[ 50lid Panel

B Frames
Mullions

Mater i al S Door /Window Assembly Style Properties - Standard

Ass|gn your typlCaI mater'als (i.e_ glass for Ian”, alumlnum General | Shape | Design Aules | Dverrides  Materiaks | Classiications | Display Froperties
for frames and mullions, etc.) Eooren . |iaaaDaon

Default Infill Doors & Windows Glazing. Glass Clear

Solid Panel Doors & Windows Wood Doors.Ash

Frosted Glass Doors & Windows Glazing Glass Frosted

Default Frame Doors & Windows Metal Doors & Frames &luminum Windows. Painted White
13544 Frame Doors & Windows Metal Doors & Frames &luminum Windows. Painted White
13248 Frame Doors & Windows Metal Doors & Frames Aluminum Windaows. Painted White
1346 Frame Dioors & Windows Metal Doors & Frames Aluminum Windaows. Painted ' hite
Detfault Mullion Doors & Wwindows Metal Doors & Frames Aluminum Windaws. Painted \whits
13xd Mullion Daors & Windows Metal Doors & Frames. Aluminum Windows. Painted white
138 Mullion Daors & Windows Metal Doors & Frames. Aluminum Windows. Painted White
136 Mullion Daors & Windows Metal Doors & Frames. Aluminum Windows. Painted White

Create Roof Trusses with Curtain Walls

Since there is no Roof Truss object in ADT,
you can usually create what you need by
converting your elevation sketch to a Curtain
Wall. Then, edit the default frame and
mullion element definitions to get your chord
sizes.
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Use Walls for Casework/Millwork

One of the most powerful features of Architectural Desktop is its Display System. It allows objects to be
displayed differently based on either your design intent (i.e. a floor plan versus a reflected ceiling plan) or
the view direction (i.e. a plan view versus an isometric).

You can take advantage of the Display System with your wall styles by creating different components for
the 2D plan view versus the 3D isometric and perspective views. This allows for more symbolic
representations of objects when viewed in plan as opposed to more detailed representations when viewed
in 3D (which lends realism to perspectives and renderings).

The following example uses a wall style to create casework. There are six components: four for the 3D
view (a base cabinet with a countertop, backsplash, and a kickplate) and two for the plan view (countertop
and backsplash):

. ) Bottom Elevation Top Elevation
M ame Priority | Width Edge Dffzet

Index Offzet | From Offzet | Fram

1 ) 1412 0" (0" [walBatiom ial Top

2 Countertop - 200 141 2 B -2 o “Wall Bottom 0" Wall Top

3 Backsplash - 3D 141 344" o o Baze Height 0" Wall Top

4 Countertop - 300 141 B = 1" o -1 142" Baze Height 0" Basze Height
5 Cabinet - 30 141 1" B 1" o 4" Bazeline -11/2"  Baze Height
B Kickplate - 3D 141 27172 Bw et 0t o Bazeline 4 Baseline

3D Components

The 3D components make up the "Model" display representation of
the casework wall style and should be as realistic as possible so they
are designed with exact dimensions.

2D Components

The 2D components make up the "Plan” display representation of the
casework wall style and are designed to be more symbolic. This is
because if the backsplash was shown with its actual thickness (3/4" to
1"), it would not print legibly at a small scale (1/8" = 1'-0" or smaller).
But, if the thickness of the backsplash is exaggerated to 2" only for the
plan view, it will read better when plotted.

Display Properties
In order for the 2D components to show up in plan view and the 3D Laya/CobitLetpe | |
components in isometric, you will need to edit the display properties Do oot s
for each of the different display representations. For the "Model" o ol D)
display representation, turn off the 2D components, leaving only the Brarebon 3 Bocktomn 0]
. . Boundary 4 [Countertop - 30 )
3D components visible. Bomdon 3 Came ) &
Boundany 6 [Kickplate - 3D) ?
For the "Plan" display representation, do just the opposite - turn off the |[EEEEEEETICRETETET
3D components and leave the 2D components visible. LS | ]
Display Component | Visible
Eelow Cut Plane @
bowe Cut Plane @
Shrink Wrap @
Shrink ‘w'rap Hatch 7]
Dslect Warning 2
Boundary 1 (Backsplash - 2D)
Boundaw 2 [Countertop-20) )
Boundary 3 (Backsplash - 3D) @
Boundary 4 [Countertop-3D)
Boundary 5 [Cabinet - 30] ?
Boundary 6 (Kickplate - 3] @
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Undocumented Autodesk® Architectural Desktop Tips and Tricks

Using in Production

You can then copy this Wall style and remove the base cabinet and
kick plate. Now, during your schematic design and design Z
development phases, you use the first wall style. Later during design 7
development and into construction documents, you can then change 71
the Wall to the style without the base cabinet and add multi-view -
blocks instead.

Take Advantage of Tool Palette Properties

Since the automatic layering in ADT is based on eslRioRerics T X
object types rather than styles, you can circumvent [T Esfresh fram:
this by placing your objects on the Tool Palettes and
assigning different Layer Keys. You can also assign e S _
. ‘ Countertop (ar.) + Backsplash + Cabinet
default roof and floor line offsets, cleanup groups, S
WIdthS, and base helghts — and that’s jUSt for walls. |E| ‘atiable witth countertop with backsplash, base cabinst, s | More Info
Each object has its own unique properties to vary.
BASIC ~
Exam p | es ) General =
= Create a “Casework” Wall style with the “CASE” DA g -
. . aver
layer key assigned, a 2'-0” default width, a 2’-10” e =
default height, a 4” roof line offset (for the Style X2 Countertop (var.) + Backsplash + Cabinet
“ ” Skyle location S0ADT 2006 StandardshCMI Imperial Standards, dvig
backsplash), and a “Casework” Cleanup Group AT e
Definition assigned. Cleanup group definition = | Casewark
o e . Definition locat i\ ADT 2006 Standards\CMI Imperial Standards,d
* Create a “Toilet Partition” Door and Wall style with B T TR
a custom layer key pointing to a toilet partition layer i o
. ” ase heigl -
as well as floor line offsets to keep them 12" off the Tustiy ] Baselne
ﬂ oor 4 Baseline offset -
. .. “iE Roof line offset from base height 4"
= Create tools for “Demolition” and “Existing” wall T
styles with custom layer keys pointing to the correct
layers (i.e. “A-Wall-D” and “A-Wall-E”) Eeanips Mo

& Graphline position
B Cleanup radius

Basic propetties

Ok Cancel Help
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Undocumented Autodesk® Architectural Desktop Tips and Trick

ﬂ Create a Standard Priority List

Each Wa” Sty|e iS made up Of one to E Jwall Style Properties - CMU-8 Rigid-1.5 Air-2 Brick-4 Furring

twenty components and each component Generol Cenpenens | atetds | Endcaps / Opening Eros | Clssfcations | Display Popetes
has its own priority for cleanup. The lower
the number, the higher the priority:

MName Priority | Width Edge Offget

Index

Brick a10 i e
At Gap 700 2" 11420
Rigid Insulation 600 11520 o
ChLl 300 a -8

Stud 500 e -8 78"
GwE 1200 BT 9142

@ e e —

If you keep consistent priorities for all your wall components, your walls
will cleanup better. For example, if you draw a wall with CMU and furring
components to a wall with brick and furring components, consistent
priority numbers will allow the furring from both wall styles to cleanup
while the brick and CMU will not:

There are three different methods to use when deciding on your priority standard: by status, by material, or
using the Architectural Desktop defaults. The following outlines all three methods.

By Status By Material

One method is to base the wall component Another method is to base the wall component priorities
priorities on the status or construction type. on the material of the component. This is usually better
This is usually better suited for interior suited for base-building architectural work. The following
architectural work. The following table is an table is an example:

example:

Existing/Core 100 Concrete 10 110 210
Framing 110 Poured 11 111 211
Millwork 120 CMU 13 113 213

Base 122 Framing 20 120 220
Overheads 124 Metal Stud 21 121 221
New 200 Wood Stud 23 123 223
Rated 210 Exterior Finishes 30 130 230
2 Hour 212 Airspace 31 131 231
1 Hour 214 Brick 33 133 233
Slab to Slab 220 Stone 35 135 235
Grid Break 230 EIFS / Stucco 37 137 237
Floor to Ceiling, Furring 240 Siding 39 139 239
User Defined 242 Interior Finishes 40 140 240
Low Walls, Partitions 250 Countertop 41 141 241
Glass Walls 260 Glass 43 143 243
Millwork 270 Tile 45 145 245
Base 272 Paneling 47 147 247
Overheads 274 Gypsum Board 49 149 249

Demolition 300 Insulation 50 150 250
Framing 310 Batt 51 151 251
Millwork 320 Rigid 53 153 253

Base 322
Overheads 324
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Undocumented Autodesk® Architectural Desktop Tips and Tricks

Architectural Desktop Defaults WALL COMPONENT PRIORITY WALL TYPE
Architectural Desktop includes Air Gap 499 Stud
hundreds of wall styles out-of-the- Air Gap 700 CMU
box. If you choose to base your wall | Air Gap 700 Stud with Brick
styles on those, the following table Air Gap (Brick Separation) 805 Brick
outlines the component priorities Air Gap (CMU) 305 CMU
used. Brick 810 CMU
Brick Veneer 810 Brick
Brick Veneer (Structural) 800 Brick
The methods outlined above are Bulkhead 1800 Bulkhead
merely a starting point. Choose a Case - Backsplash 2030 Casework
method that is best for your type of Case - Base 2010 Casework
work and modify it to fit your needs. Case - Counter 2020 Casework
Case - Top 2000 Casework
CMU 300 CMU
CMU (Veneer) 350 CcMU
Concrete 200 CMU with Footing
Concrete (Footing) 200 Concrete
GWB 1200 Brick
GWB 1210 Stud - only for outside second layer
Rigid Insulation 600 CcMU
Rigid Insulation 804 Brick
Sheathing 600 Stud
Siding 900 Stud
Stud 500 Brick
Unnamed 1 Standard

Create Endcaps with an Open End

You can create wall endcaps with open ends by adding a width (anything greater than 0) to the polylines
you use to generate your endcaps. This can be done for an entire endcap or just one wall component.

This can be useful if you are modifying a
large drawing that was drawn with just
lines but you need to add walls to just a
small section of that drawing. An open
endcap will allow you to draw wall objects
for the new work while still leaving the old
lines.

Plan View 3D View
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Undocumented Autodesk® Architectural Desktop Tips and Trick

ﬂ Draw Endcaps Right to Left

Always draw wall endcaps from the right face of the CORRECT INCORRECT
component to the left face of the component, not Drawn Right-to-Left Drawn Left-to-Right
necessarily counterclockwise (as is usually published). (counter-clockwise) (counter-clockwise)
Drawing the wall from South to North will help you —=_ —

establish which is the left and which is the right face: - =

/] |/

M

- LI
L= —1

Drawn Right-to-Left Drawn Left-to-Right
(clockwise) (clockwise)

E Use Mass Elements for Difficult Wall Cleanups

Sometimes walls do not cleanup exactly as they would be built. Because of this, you
may need to do some extra work to get them to display exactly as intended.

The following example uses two walls cleaning up at a sharp angle. The resulting
pointed intersection does not represent the true construction.

To fix this problem and give the wall a butt end, follow these steps:

1. Insert a Mass Element
Add a mass element the correct size and shape to mask the problem. Make sure to
size it big enough (including the height). This example uses a "Box" mass element.

Highlight the walls, right-click, go to "Model Tools", and choose "Interference.” Use
the "Add" option, select the Mass Element, then choose "Subtractive" for the
shrinkwrap plan effect.

2. Add an Interference Condition w

Finally, place the mass element on its own layer (preferably a non-plotting layer) and
freeze it or turn it off. A suggestion would be to have a layer just for these situations
such as: "A-Wall-Nplt"

w 3. Freeze the Mass Element
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10 ‘ Use Body Modifiers to Create a Bullnose

You can create rounded wall corners (bullnoses) using Wall Body Modifiers. Follow the steps below:

Create either a 3D Solid or Mass Element in the shape of a square with a "bite" out L
of the corner (a quarter-round piece with the same radius as the desired bullnose).

Insert it at the wall corner like the example. You may want to create a block for
each bullnose radius that resides in your template.

Subtractive Body Modifier
Highlight the first wall, right-click and choose "Body Modifiers", then "Add...".

Select the body you created, choose component of the wall to add the bullnose,
and set the operation to be "Subtractive”, give it a description, but don't erase the
original so you can use it for the other wall. Finally, repeat the process for the
other wall, this time checking the box to have the Body Modifier erased.

Use Wall Modifiers for Complex Cleanups

When components change width from one wall to the next, sometimes
the other components cannot adjust and cause a defective wall cleanup.
In this example, the CMU becomes wider and the stud furring does not
know how to cleanup properly.

You can make the furring and gypsum board wrap around the CMU and
continue on without a defect by using wall modifiers with open ends.

1. Draw Polylines L, =y
First, draw a polyline for each component you need to fix (in this S
example, one for the furring and one for the gypsum board). Draw the
polyline so that it starts and ends from one side of the component. Do
not draw a closed polyline, leave it open. When drawing the polyline,
make sure to keep the width of the polyline set to zero (0), except where
it connects to the same component on the other wall segment. The
following picture shows the two walls segments with the defect, the
polyline to use for the stud component drawn in bold, and an enlarged L |
view of that same polyline. Notice the segment of the polyline with its

width set to something greater than zero.

] ]

2. Convert Polylines to Wall Modifiers - —
After the polylines are drawn, place them in their correct position. e

Then, highlight the wall the polylines start from, right-click, and e
choose "Plan Modifiers > Convert Polyline to Wall Modifier..." ezfeerlics

Interference Condition

Clasrups

AUTODESK
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Undocumented Autodesk® Architectural Desktop Tips and Trick

Follow the prompts to erase the polyline, give the modifier a name, and
then choose which component is being modified when the dialog box
prompts you. Repeat for the other modifiers if necessary.

Sometimes, because you are placing a modifier so close to the end of a
wall, the modifier may shift away from that end. Notice how the Gypsum
Board has shifted.

3. Change the Position of the Wall Modifier vl bockore
You can edit the position of any wall modifier through the wall CO O T R N T
properties by clicking the small grey icon next to the “Plan e e
Modifiers” property. There you will be able to highlight the shifted st st
Gypsum Board modifier and change the value for the "Start
Position Offset" to 0". g Eowme]
Companert Mame: e
Apply To: W
Start Position Offset: r i

The final product should look like this:

Change Insertion Points on Multi-View Blocks

When inserting certain multi-view blocks from the DesignCenter, you may have noticed some extra points
on them. These extra points allow you to change their insertion points as you add them.

Changing Insertion Points
Just double-click on the multi-view block from the DesignCenter to bring up the "Add Multi-View Block"
dialog box. When you see the block on your cursor, simply tap the CTRL key and it will cycle through all

the extra insertion points.
() () (™
) )0

Creating Your Own Extra Insertion Points

You can create your own extra insertion points in your multi-view blocks by adding POINT's to one of the
view blocks of your multi-view block (usually the one shown in the Top view). Just place these points on
the DefPoints layer and they will be recognized whenever that multi-view block is inserted.

Take Advantage of the NODE OSnap

The most effective way to get walls to cleanup correctly /

is to have their “grip lines” match up. Sometimes it is |
difficult to know where another wall’s grip line is located. &

Using the NODE Object Snap (OSnap) will allow you to

snap directly to the endpoint or midpoint of a wall’s grip [Node |
line.
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14 ‘ Don't Use Solids for Multi-View Blocks

ACES Solids, a standard AutoCAD entity, are the preferred tool for AutoCAD 3D modeling. But, there is a
better option to use when creating the 3D view blocks for Multi-View Blocks, instead use Mass Elements.
Here are the advantages...

Easier to Edit
They are easier to edit because sizes can be easily adjusted with
trigger grips. Depending on the way the Mass Element is created -

either by adding one using a primitive shape (box, cylinder, etc.), TS B
converting a closed polyline, or converting a 3D solid — will yield vl T
different types of trigger grips including: edge, face, location, and LT
vertex. g™
They also support Boolean operations ~ The only operations Mass Then convert it back to a
(add, subtract, union) just as 3D Solids  Elements do not support that 3D Mass Element when you
do as well as other functions such as Solids do is Fillet and Chamfer. To  are finished:
trimming by a plane or splitting by a get around this, you can convert a E——
plane or a face: Mass Element to a 3D Solid to use :

s UL ’ these two commands: el ShEds ’

Basic Modify Tools » Basic Modify Tools 3

Clipboard » CAD Managet | 30 Solids  “Window  Help Clipboard 3

Box Comvert bo Mace Elarme
B Coreert to Mass Element
m’ Lol

Split by Plane Subtract CE:::der conert to Wal k

Trirn by Plane Intersect Sphere EAiF Fbiark Fienlau

Split Face 1 Tarus

Jioin Faces wedge

Corwert ta wall

Caonvert ta 3D Solids

Extrude
Revolve

More Efficient
Mass Elements not only result in a smaller file size, but are more efficient than 3D Solids when shading and

rendering.
Contain Materials
You can create different Mass Element Styles based on the Material Flle Edt Wiew
you want to represent and then assign that Material to the style. For DR e || EEW
example, you could create Mass Element Styles such as "Countertops - ~
TRRT} . non " = Casework, dwg
and Backsplashes", "Base Cabinets", "Doors and Drawer Fronts", and (] Architactural Objects
"Hardware" to use when creating components to use for casework ] Documentation Cbjects
Multi-View Blocks. B Multi-Purpose Objects

E|l— Mass Element Styles
- Base Cabinets
I— Countertops and Backsplashes
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15 |

Add Wipeouts to Symbols

Instead of constantly having to trim linework and hatch inside of your
furniture and annotation symbols, add a Wipeout to each symbol so ‘
they can hide anything behind them. -

- / ..\\\. /
Just make sure to use the DRAWORDER command to move the / ( }
Wipeout to the back of the symbol and to turn the frames off in your y -
template (using the IMAGEFRAME command). If you have 2006, you
can set it to “2” which will keep the frames from plotting.
Create Custom Components
It is possible to add your own components to objects, such as = Openings, Doors, and Windows
hardware and panels to a Door or a custom mullion profile to a = Door/Window Assemblies
Curtain Wall. Many objects allow you to add your own custom = Curtain Walls and Units

components by creating standard blocks and attaching them to = Railings
one or more Display Representations of an object. These objects = Structural Members
include:

These are the general steps you would take to create a custom —
component:

1. Draw Your Custom Component
Use lines and polylines for 2D geometry, Mass Elements for 3D.

In this example, the custom components are the panels on a — i

Dutch door. =

2. Set All the Properties

Set the layer, color, linetype, and lineweight to "BYBLOCK" — this p. —
is important and will be necessary if you ever want to modify the

display properties of that component (i.e. so that the component
you created as door hardware shows up with a different color in
3D view versus the door panel).

3. Make a Block
Turn it into a standard AutoCAD block, making note of its insertion
point.

4_ Add the Cu stom BlOCk to the Sty|e Edpisplay Properties {(Door Style Override - Single - Dutch) - Dol
Go to the "Other" tab in the Object Display Properties of the object e L
to change (modify at the Style level or Object level, never at a s
Drawing Default level).

Add

Attach your custom component to each Display Representation Ed
that is appropriate and change the settings for where it is inserted FE

and how it scales (in this example, there is a 2D block of the door
panel attached to the "Plan" Display Representation and a 3D
block attached to the "Model" one.

5. Ch ang e th e D| Splay PrO perti es [ Apisplay Properties {Door Style Dverride - Single - Dutch) - Dol
Modify its properties on the "Layer/Color/Linetype" tab for each e e [ |
Dlsplay Representation. Display Component “V}\S\HE [ B ] Layer ‘éﬂ};r

Door Panel
W 251

Frame

Stop [ Pl
Swing W EYBLOCK
Glass @151

Dutch Door Panel (Modell ()

AP
o

ao#n
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17 ‘ Have Those Custom Components Automatically Resize

The custom blocks you create for objects (see the previous tip called "Create Custom Content") can
automatically size themselves to fit in all three directions (X, Y, and Z). Whenever these calculations are
made to automatically resize, they are based on the overall extents of the custom block. This may not
always be what is desired.

The following example shows a This is how the
custom door frame that is resizing frame should
based on its overall extents. You will react.

see that because of this, the casing  _____

ends up inside the wall (since it is ]]

fitting to the wall width.

This can be accomplished by adding POINT entities to the custom block and
placing them on the DefPoints layer. For this example, the original block looked
like this:

The POINT's were added to the opposite corners of the jamb. This way, the width
of the custom block is sized based on the extents of the POINT's on the DefPoints
layer and not the overall extents of all the geometry. Now, the custom block will
change its width so that the jamb matches the wall width.

18

How Best to Define Display Properties

Whenever editing the Display Properties of all object components, it is best to follow these two rules.
They will give you more flexibility by allowing components to be controlled by layers as well as make your
consultants happy when they receive your drawings.

0, ByBlock Layer, ByLayer

Choose Layer 0 for the layer, then set all If you need a particular component to be different
properties to “ByBlock”. This will cause the than the object layer, then set that layer and change
component to take on all the properties of all the other properties to “ByLayer”.

whichever layer the objected is inserted.

Display Properties (Wall Style Override - Type D - Ceiling Height (¥ar.)) - Pl: x|

Layer/Calor/Linetype | Hatching | Cut Plane | Other |

Dizplay Component | Yigible | By Mat.. | Layer | Colar | Linetype | Lineweight |
Below Cut Plane . =] A 3ll-Prit O EYLAYER Byl ayer BylLayer
Above Cut Plane ] ] A all-Head O EYLAYER Byl ayer BylLayer
Shiink wrap " O i M EYELOCK ByBlock EyBlock
Shiink Wrap Hatch ] O i M EYELOCK ByBlock EyBlock
Defect Warning . [ A-dnno-Mplt O EYLAYER Byl ayer ByLayer
Boundary 1 [Metal Stud) " a W EYELOCK ByBlock ByBlock
Hatch 1 [Metal Stud) 9 a W EYELOCK ByBlock ByBlock
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Organize Schedule Data

Schedules allow you to extract information from objects and entities that can be placed in tables for
reference. This schedule information can either be automatically generated from the properties of the
object (such as size), or can be manually assigned (such as material and cost).

When you design your own Property Set Instead, add a number before each property so that
Definition containing the different properties you they end up in a more logical order:

would like to schedule (i.e. door number, width,

height, remarks, etc.), those properties will be

listed alphabetically when you use the "Extended

Data" tab of the Properties palette:

x *
Doar ~| Dioor M e 4
B S L 5
i i
a =3
SRR PROPERTY SETS 2 SR PROPERTY SETS R
© CMI Door Object ~ @ CMI Door Object ~
E Door_Material HowD E 01-Number ADDIE
H it Door_Size F-0"xe-g" H 0z-Room_Mumber AD01
= Doar_Type ] B % 03-Door_Size 30 x 68"
- Frame_Material HM £ 04-Doar_Type I
& Frame_Type B 6z 05-Door_Material SCWD
Hardware 1C Dé-Frame_Type A
Head H3 07-Frame_Material Hi1
Jamb 11 08-Head Hz
Label - 09-Jamb 1z
Mokes - 10-Thraat 35/8"
Number AODLE 11-5il 51
Raoam_Mumber A001 12-Hardware 18
sill st o 13-Label - o
Throat 3se" = 14-Niotes =
& &
® 5 ® g
=1 =}
g g
Attached property set data for the object i Attached property set data for the object i
] ]

This way, when you edit the different properties, they are displayed in the same order as your schedule
table, making it less confusing.

0J0R SCHEOULE

DoOR oM |vooe s7p [RUCR(BOOR\TRAME 1 FME | can | ae| ToRT |1 (Misae. o |oes
sk |a0dn Ti" x =0 Ean e H |1 359"|52 [ == |1 4R BMEC
Randh  [mod o« 0" |4 s |4 Ihi e | |isas |

Mg (a0 F=0"x F=6"[8 W |4 H B (3575 B == ==

ATAN an gy [ | W F Wi H n 3 54% 51 1w == |==

i A EE s N ] WD E Ll H A 351 |G == |==

Some Things to Consider

If you use this technique, make sure you update the attribute definition in your schedule tag (more
specifically, the plan View Block of the Multi-View block definition used for the schedule tag) to account for
the added number in front of the property. See the tip called "Creating Tags for Scheduling" for more
information.

AUTODESK
UNIVERSITY
2005




Undocumented Autodesk® Architectural Desktop Tips and Tricks

20

Use Layer Key Styles to Change the Status of Objects

Even though AEC Objects (walls, doors, windows, etc.) are "keyed" to a particular layer upon insertion,
they can also be re-keyed to a different layer afterwards. In other words, you can move an entire set of
objects, without selecting them individually, to different layers with one command.

A good example of this would be to take an existing drawing and move part or all of the objects to their
corresponding demolition layers (i.e. doors would move from "A-Door" to "A-Door-D"). This can be
achieved by using two different Layer Key Styles - one for your new work and one with the layers adding
the "-Demo" or "-D" status field at the end of the layer name (as well as changing the color and linetype).

Have the new work Layer Key Style set current Then, use the "Remap Object Layers" command

for most of your drawings, but when you're ready  accessed from the "Format" pulldown, then choosing
to make a Demolition plan, set that Layer Key the "Layer Management" option (for ADT 3 and 3.3,
Style current: from the "Desktop" pulldown, "Layer Management"):
Insert | Format Tools Draw Dimension Modify Express

E’ Style Manager.. .

Units I Scale  Lapering |Disp|ay|
m Display Manager...

Layer Standaids/Key File to Auto-Import:

IAecLayarSld dwg Layer Management

=i Laver Manager ...
\Q Select Laver Standard. ..

Structural Members L4

r—Diefault Layer Standard

D‘H Layer Key Styles. ..

Layer Key Sityls Base AEC Dimension Style Wizard, ., =i P
CMI [New] *current drawing j Chdl v_'vlt_' AEC Dimension Styles. . = Layer Key Overrides. ..
<Cunent Laper> Dimension Style. ..
412 (256 Color) .ﬁ o] 'yl Overrides Onfoff
Al (256 color) ADT R3 ;
B51192 UG Yersion 2 (256 Calar] AEC Conereivza
B51192 Descriptive [256 Color] Define Schedule Tag. ..
Chdl [Demalition] *current drawing i L
ChI [Mew] “cument drawing k used in Mlicis Bl
_DIN 276
— g Generic Architectural Desktop | —
Standard *current drawing
TLE H Layer
=/Key F

Defaull"', and click "OK"

Finally, select the objects to change and use the "ByObject" option.

Use the DesignCenter for Standard Commands

Only Objects use Layer Keys, allowing them to automatically place themselves on designated layers. But,
you can make entities behave the same way by placing standard AutoCAD commands in the
DesignCenter using the AEC Content Wizard. Then, you can either drag-and-drop that command from the
DesignCenter, or you can place it on a tool palette for one-click access.

Just use the “Custom Command” option and type in  Then, on the next window, assign a Layer Key:
the command in the “Command String” field:

Create AEC Content Wizard x| Create AEC Content Wizard x|
- Contertt Type lnsetOptions | [~ Attribute Text Style
» Content Type Content Type
w C Block i I= Enploce O Irsert ) 45 Defined by Content
Insert Options ) » Insert Options
" Draving Freset Elevation [
Display Options " Display Options ) Target Drawing Tiext Style
© Muliiiiew Block
Anchar Tepe Nane -
> " Masking Block b
ﬁ ' Custom Command ﬁ [~ Scale [ Attribute Text Angle
(=3 (= — Additional Scaling
o Current Drawing: Content File: (o} Z |T - & bsInserted
Q' s Q' + MNong
g 8 i IWH— 1 Anngtation " Force Horizontal
= e 3 € Drawing
¥ Add>>> J < | - " Right Reading
<<¢ Remove I~ Enable AEC Unit Scaling
[ Layer Key
Command Stting IEEILEHID Select Laper Key |
_-Hatch_PROPERTIES user 0124 yes _ADVANCED _ASSOCIATIMAT | Expand..
2Back Nest > Cancel Help <Beck [ Mews | Cancel | Hep |
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22 ‘ Use Meaningful Colors

Everyone is accustomed to AutoCAD colors equating to lineweights (as well as plotted color and
screening) when plotting. There are a few other ways to use colors in AutoCAD.

"Wrong Layer" Color

Select a color to let users know that any object with that color is on the wrong layer and needs to be
moved to the correct layer. A good way to utilize this is to make layer "0" this color so that users know to

not keep objects on that layer.
Non-plotting Color

Reserve a color so that your users will know that whenever
they see that color, that object will not plot out, regardless
of what layer it is on. Use this color for the following:

= All non-plotting layers such as DefPoints, Viewports,

etc.

= Assign it to AEC Object components that should be
visible, but not plotted, such as defect warnings,

markers, baselines, etc.

Display Properties (Wall Style Override - Standard) -

Laver/Colar/Linetype | Hatchingl Cut F'Ianel Other I

Dizplay Compatent | Wi | E.. | Layer | Calar

Below Cut Plane Qg Wm0 HEYELOCK
Above Cut Plane 9 E 0 M EYELOCK
Shiink ‘wrap G Een W EYVBLOCK
Shrink wrap Hatch 9 EED W EYELOCK
Defect Warming W O 0 243

Boundarp 1 (Unnamed) ¢ [ 0O W EYELOCK
Hateh 1 [Unnarmed) J [0 M EYELOCK

N
!

Use Special Characters for Names

Even though you cannot use system characters (such as /\ ? : ) to name items (such as layers, object
styles, layouts, etc.), there is another way. The Windows Character Map will allow you to use special
characters such as ¥, ¥, and %. It is usually found from:

Start > Programs > Accessories > System Tools > Character Map

You may have to change the font (from the top
pulldown) to Arial, but then you can double-click
on the character you want and then choose the
"Copy" button. Not all characters will work; you
will need to experiment with different ones.

Examples

One way to take advantage of special characters is with
wall styles. It will allow you to call out actual sizes:

_'d] Style Manager
File Edit Wiew

DR D6 | of|Cailn{

= [EP Al01.dwg

=177 Architectural Objects

=y
3% inch Interior Stud Partition
5% inch Inkerior Stud Partition
: ] standard
i{2] Documenkation Objects
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& Character Map =10 x|

Font: [O Arial =1 Help
! #$%&'()*+‘—.101234ﬂ
5|6|7|&[8 === @ A|B|CIDIE|F|GIH
I [KLIM{N|OP|QIR| S T|UY X Y[ Z] [ Y
M |alble|del flglh]i|i|k{!|m{n]ja|p
alr{s|tiu|viw|x|v|Z[{[||}|~ i |RE]a|¥
IHNCEOREEREEEEENELIERE
o wlwafrefal o | A A A Al A AlEC|E[E|E|E] T] T
IR ELNEEEEEREE NN NEEBEE
alala|ale|gle|é||eli|l|T|T|d]A0|6|5|6
o*ﬁuuﬂuybyﬁéﬁ\é/ﬂ\a(ié@él‘

Characters to capy |1/2 Select | [Eupy

I~ Advanced visw

[ L+00ED Vlgar Fraction One Hal Keystroke: Alt+0183

Another way is to name layouts by their
sheet size:

[MTATw [ Model  8%x11 7
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24 ‘ Simple but Helpful LISP Routines

Many people see the term “LISP” and assume you need to be a programmer to work with it. That’s not the
case. Use the following diagram to design your own LISP routines that will use AutoCAD and ADT
commands, including their options.

(defun c:ZE () (command "._ zoom" "extents") (princ);

ZE ._zoom extents

Replace this with whatever you Replace this with the actual Replace this with any options for

want to type in at the command AutoCAD or ADT command. The the command. You can put more

line to run your new routine. “._ " part is there to make sure it than one option and these are
uses the English version of the some helpful ones”

wn

command, even if it is undefined. = “” — use this to represent an
<ENTER>

= pause — use this (without the
guotes) to wait for input, like to

pick a point

Just type these in Notepad, then save the file as “Acad.Isp” in your support file search path. Now, you will
be able to use these routines on any drawing. Here’'s some of my favorites:

Zoom Extents
(defun c:ZE (Q(command '._zoom'™ "extents'™)(princ))

Zoom Extents then zoom out 10%
(defun c:Z2Z (Q(command ". zoom" "extents')(command ''._ zoom" ".9x'")(princ))

Zoom to 1/8" = 1'-0" scale
(defun c:Z28 (Q(command *._ zoom"™ "1/96XP'")(princ))

Thaw all layers
(defun c:LTA (Q(command . -layer™ 'thaw™ "*" "")(princ))

Offset 6 inches
(defun c:6 (Q(command *._offset” "'6'))

Break at a single point
(defun c:BA (Q(command '. break' pause "first" pause "@")(princ))

Purge everything in the drawing
(defun c:PG QO (command *. -purge™ "all'™ "*" "no")(princ))

All of these Tips and Tricks and more can be found at: www.caddmicrosystems.com/adt
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